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POPIS KRATICA 

 

BMI – indeks tjelesne mase (engl. body mass index) 

GDM – gestacijski dijabetes melitus (engl. Gestational diabetes mellitus) 

IDF – Međunarodna dijabetička federacija (engl. International Diabetes Federation) 

IADPSG – Međunarodna skupina za istraživanje dijabetesa u trudnoći (engl. International 

Association of the Diabetes and Pregnancy Study Groups) 

GLUT4 – transporter glukoze 4 (engl. Glucose transporter type 4) 

HFHSD – prehrana bogata mastima i šećerima (engl. High-fat and high-sugar diet) 

hPGH – humani placentarni hormon rasta (engl. Human placental growth hormone) 

hPL – humani placentarni laktogen (engl. Human placental lactogen) 

IGF-1 – faktor rasta sličan inzulinu (engl. Insulin-like growth factor 1) 

IR – inzulinski receptor (engl. Insulin receptor) 

IRS - supstrata inzulinskog receptora (engl. Insulin receptor substrate) 

IR-α – inzulinski receptor alfa (engl. Insulin receptor alpha) 

mTORC2 - mTOR kompleks 2 (engl. mTOR Complex 2 ) 

OGTT – oralni test opterećenja glukozom (engl. Oral glucose tolerance test) 

PCOS – sindrom policističnih jajnika (engl. Polycystic ovary syndrome) 

PDK - kinazu ovisnu o fosfoinozitidu (engl. Phosphoinositide-dependent kinase) 

PI3K - fosfatidilinozitol-3-kinaza (engl. Phosphoinositide 3-kinases) 

PIP3 - fosfatidilinozitol-3,4,5-trifosfat (engl. Phosphatidylinositol (3,4,5)-trisphosphate) 

SD – standardna prehrana (engl. Standard diet) 

TNF-α – čimbenik nekroze tumora alfa (engl. Tumor necrosis factor alpha) 
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1.UVOD 

 

1.1. Gestacijski dijabetes melitus  

 

Gestacijski dijabetes melitus (GDM) vrlo je česta komplikacija za vrijeme trudnoće pri 

čemu dolazi do spontanog razvoja hiperglikemije. U većini slučajeva, hiperglikemija se 

razvija zbog smanjene tolerancije glukoze, odnosno zbog disfunkcije β-stanica gušterače (1). 

Tijekom trudnoće povećavaju se potrebe za inzulinom kao posljedica povećanog unosa 

kalorija, povećanja tjelesne mase majke, prisutnosti placentarnih hormona te zbog povećanog 

lučenja prolaktina i hormona rasta. Napredovanjem trudnoće povećava se masa β-stanica 

gušterače kako bi se zadovoljila povećana potreba za inzulinom. Ukoliko ne dođe do 

ekspanzije β-stanica te ne dođe do porasta lučenja inzulina, dolazi do razvoja GDM-a (2). 

Prema najnovijim procjenama (iz 2021.) Međunarodne dijabetičke federacije (engl. 

International Diabetes Federation - IDF), GDM javlja se u približno 16,7 % trudnoća u 

svijetu, što predstavlja 21,1 milijun poroda godišnje. Do razvoja GDM-a češće dolazi u 

zemljama s niskim i srednjim dohotkom s ograničenim pristupom zdravstvenoj skrbi trudnice 

(3). Prema podatcima koji se svake godine objavljuju u Hrvatskom zdravstveno-statističkom 

ljetopisu GDM jedna je od najučestalijih komplikacija u trudnoći. Prevalencija gestacijskog 

dijabetesa u Hrvatskoj 2014. godine iznosila je 4,7 %, 2016. 7,0 %, 2018. 4,9 % te 2021. 4,1 

% (4). Međunarodna skupina za istraživanje dijabetesa u trudnoći (engl. International 

Association of the Diabetes and Pregnancy Study Groups - IADPSG) postavila je kriterije za 

dijagnozu GDM-a. Ukoliko na prvom pregledu koncentracija glukoze u plazmi natašte iznosi 

5,1 - 7,0 mmol/L, postavlja se dijagnoza GDM-a. Međutim, ukoliko koncentracija glukoze u 

plazmi natašte iznosi manje od 5,1 mmol/L, između 24. i 28. gestacijskog tjedna radi se oralni 

test opterećenja glukozom (engl. Oral glucose tolerance test - OGTT) (5). OGTT traje dva 

sata, pri čemu se određuje koncentracija glukoze u plazmi natašte, zatim trudnica popije 75 g 

glukoze otopljene u vodi pri čemu glukoza u plazmi nakon 1 sata treba iznositi manje od 10,0 

mmol/L, a nakon 2 sata manje od 8,5 mmol/L (6). Ukoliko koncentracije glukoze u plazmi 

iznose više od referentnih vrijednosti, postavlja se dijagnoza GDM-a. 
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1.2. Čimbenici rizika za razvoj gestacijskog dijabetesa melitusa  

 

Zbog promjene načina života, odnosno zbog nepravilne prehrane i nedovoljne fizičke 

aktivnosti, dolazi do porasta broja pretilih osoba, kako muškaraca tako i žena. Kod žena 

reproduktivne dobi prekomjerna tjelesna masa predstavlja veliki problem jer je jedan od 

glavnih čimbenika za razvoj GDM-a. Osim prekomjerne mase, rizični faktori za razvoj GDM-

a uključuju prekomjerno povećanje mase za vrijeme trudnoće, zapadnjački način prehrane, 

etničku pripadnost, genetski polimorfizam, intrauterino okruženje (visoka ili niska porođajna 

masa), obiteljska ili osobna povijest GDM-a te druge bolesti koje uključuju inzulinsku 

rezistenciju kao što je sindrom policističnih jajnika (engl. Polycystic ovary syndrome - PCOS) 

(1). Starija životna dob majke predstavlja visoki rizik za razvoj različitih komplikacija tijekom 

trudnoće, isto tako i za razvoj GDM-a te je vidljiv pozitivan odnos između povećanja životne 

dobi majke i mogućnosti razvoja GDM-a. Nadalje, prekomjerna tjelesna masa majke prije 

trudnoće (indeks tjelesne mase (engl. Body mass index - BMI) 25-29,99 kg/m2) ili pretilost 

(BMI ≥ 30 kg/m2) predstavljaju čimbenik rizika za razvoj GDM-a. Rizik za razvoj GDM-a 

povećava se 3 do 4 puta u odnosu na žene s normalnim BMI (7). Prehrana s visokim udjelom 

zasićenih masti, rafiniranih šećera te crvenog i prerađenog mesa povezuje se s povećanim 

rizikom za razvoj GDM-a, dok se prehrana bogata vlaknima, mikronutrijentima i 

polinezasićenim mastima povezuje sa smanjenim rizikom za razvoj GDM-a. Zasićene masne 

kiseline izravno ometaju inzulinsku signalizaciju te djeluju upalno i mogu uzrokovati 

endotelnu disfunkciju što predstavlja čimbenike za razvoj GDM-a (1). Također, na 

životinjskim modelima i istraživanjima na ljudima dokazano je da prehrana bogata šećerima 

smanjuje inzulinsku osjetljivost i izlučivanje inzulina (8). Ostali rizični faktori uključuju 

blizanačku trudnoću, prethodnu makrosomiju, povijest perinatalnih komplikacija, malo 

novorođenče u odnosu na gestacijsku dob, tjelesna neaktivnost, prehrana s niskim sadržajem 

vlakana i visokim glikemijskim indeksom, povećan unos masti i smanjen unos ugljikohidrata 

te lijekove kao što su glukokortikoidi i antipsihotici (7). 
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1.3. Posljedice gestacijskog dijabetesa melitusa  

 

1.3.1. Posljedice gestacijskog dijabetesa melitusa za majku 

 

Žene koje tijekom trudnoće razviju GDM izložene su povećanom riziku od 

opstetričkih intervencija uključujući indukciju porođaja, carski rez i komplikacijama 

povezane s porodom, a koje uključuju perinealne laceracije i rupturu maternice, najčešće 

povezane s fetalnom makrosomijom i polihidramnionom (7). Nadalje, žene koje razviju GDM 

najčešće imaju visok BMI i loš metabolički profil i prije trudnoće, što uključuje visoki ukupni 

kolesterol, trigliceride te nisku razinu HDL kolesterola. Također, kod većine žena koje razviju 

GDM dolazi do porasta indekse tjelesne mase i razvoja pretilosti, povećanja krvnog tlaka i 

ukupnog kolesterola. Kao rezultat toga, žene s prethodnom poviješću GDM-a imaju povećane 

koncentracije kalcija u koronarnim arterijama i zadebljanu intimu i mediju karotide, koji 

predstavljaju podlogu za razvoj ateroskleroze i kardiovaskularnih bolesti nakon poroda (9). 

Iako se hiperglikemija koja nastaje za vrijeme trudnoće povlači nakon poroda, kod žena s 

prethodno dijagnosticiranim GDM-om postoji povećan rizik od 50 % za razvoj dijabetesa 

melitusa tip 2 kasnije u životu (10). Također, postoji povećan rizik od dodatnih komplikacija u 

trudnoći, uključujući prijevremeni porod i preeklampsiju (1). Prisutnost GDM-a, zajedno s 

drugim čimbenicima rizika kao što su hipertenzija i pretilost tijekom trudnoće, također može 

dovesti do prijevremenog poroda (7). Osim toga, konzumacija velikih količina šećera tijekom 

trudnoće povezuje se s ranim prijevremenim porodom, jer što je fetus nezreliji to je veća 

njegova osjetljivost na koncentracije interleukina koje su povezane s prijevremenim porodom 

(11). Preeklampsija je definirana kao stanje u kojem sistolički krvni tlak iznosi ≥ 140 mm Hg 

ili dijastolički krvni tlak iznosi ≥ 90 mm Hg u dva navrata u razmaku od najmanje 4 sata, te se 

povišeni krvni tlak javlja zajedno s proteinurijom, trombocitopenijom, bubrežnom 

insuficijencijom, oštećenom funkcijom bubrega, plućnim edemom te cerebralnim ili vidnim 

simptomima, a koji se javljaju nakon 20. gestacijskog tjedna (12).  

 

1.3.2. Posljedice gestacijskog dijabetesa melitusa za dijete  

 

Tijekom trudnoće u kojoj se javlja GDM dolazi do povećanog placentarnog transporta 

glukoze, aminokiselina i masnih kiselina koje stimuliraju fetus na endogenu proizvodnju 
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inzulina i faktora rasta sličnog inzulinu (engl. Insulin-like growth factor 1 - IGF-1). Pojačano 

lučenje navedenih faktora može uzrokovati prekomjerni rast fetusa, što često rezultira 

makrosomijom pri rođenju (1). Makrosomija se obično definira kao porođajna masa iznad 90. 

percentile za gestacijsku dob ili > 4000 g (13). Distocija ramena, ozljeda brahijalnog pleksusa, 

ozljede kostura, aspiracija mekonija, perinatalna asfiksija, hipoglikemija i smrt fetusa 

komplikacije su koje mogu nastati kao posljedica makrosomije (14). Nadalje, makrosomska 

novorođenčad izložena su povećanom riziku za razvoj dijabetesa melitusa tip 2, hipertenzije 

te pretilosti u odrasloj dobi (15). Smanjena kontrola glikemije za vrijeme začeća i tijekom 

prvog tromjesečja povezana je s višim stopama kongenitalnih anomalija (16). Provedeno je 

istraživanje kako bi se usporedio rizik za razvoj kongenitalnih anomalija kod trudnica s 

pregestacijskim dijabetesom, GDM-om i kod trudnica bez dijabetesa. Istraživanje je pokazalo 

da u trudnoćama s GDM-om isto kao i u trudnoćama s pregestacijskim dijabetesom postoji 

povećan rizik za razvoj nekih kongenitalnih anomalija kao što su kongenitalne srčane bolesti, 

hipospadija, rascjep usne s ili bez rascjepa nepca, Downov sindrom, spina bifida te povećana 

mogućnost razvoja kromosomskih poremećaja (17). Također, uočen je povećan razvoj 

pretilosti kod potomaka majki s GDM-om koji je povezan s povećanim rizikom za razvoj 

metaboličkih poremećaja uključujući kardiovaskularne bolesti i inzulinsku rezistenciju (10). 

Istraživanje je dokazalo da je GDM povezan s povišenim stopama razvoja specifičnih 

psihijatrijskih poremećaja kao što su shizofrenija, anksiozni poremećaj, intelektualne 

poteškoće te poremećaji u razvoju i ponašanju, međutim nije povezan s raspoloženjem, 

upotrebom supstanci ovisnosti ili poremećajima u prehrani. Navedeni poremećaji uočeni su 

od djetinjstva nadalje kod potomaka koji su bili izloženi GDM-u (18). Nadalje, hiperglikemija 

tijekom trudnoće značajno je povezana s razvojem hiperglikemije i inzulinske rezistencije kod 

potomaka u njihovoj odrasloj dobi što dovodi do povećanja rizika za razvoj dijabetesa (10). 

 

1.4. Molekularni mehanizam gestacijskog dijabetesa melitusa i inzulinski 

receptori u miometriju  

 

1.4.1. Molekularni mehanizam gestacijskog dijabetesa melitusa 

 

GDM obično je rezultat disfunkcije β-stanica na pozadini kronične inzulinske 

rezistencije tijekom trudnoće, stoga i oštećenja β-stanica i inzulinska rezistencija tkiva 
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predstavljaju uzroke razvoja GDM-a (1). Inzulinska rezistencija definira se kao neuspjeh 

ciljnih organa da normalno odgovore na djelovanje inzulina. Uzrokuje nepotpunu supresiju 

izlučivanja glukoze iz jetre i smanjen unos glukoze posredovan inzulinom na periferiji 

(skeletni mišići, masno tkivo), što dovodi do povećane potrebe za inzulinom (19). Vezanjem 

inzulina za inzulinski receptor dolazi do aktivacije kaskade fosforilacije proteina koji 

reguliraju stanični metabolizam. Kinaza Akt nalazi se u središtu kaskade te do njene aktivacije 

dolazi „prokismalnim inzulinskim signaliziranjem“ (20). Nakon vezanja inzulina, aktivira se 

tirozin kinaza inzulinskog receptora (IR) te dovodi do tirozinske fosforilacije IR-a i supstrata 

inzulinskog recepotora (engl. Insulin receptor substrate - IRS). Fosfotirozinska mjesta na 

IRS-u omogućuju vezanje lipidne fosfatidilinozitol-3-kinaze (PI3K) koja sintetizira 

fosfatidilinozitol-3,4,5-trifosfat (PIP3) na staničnoj membrani. PIP3 regrutira kinazu ovisnu o 

fosfoinozitidu (engl. Phosphoinositide-dependent kinase - PDK) koji izravno fosforilira 

treoninski ostatak Akt kinaze. Nakon toga dolazi do druge fosforilacije Akt kinaze pri čemu 

fosforilaciju provodi mTOR kompleks 2 (mTORC2) na ostatku serina. Fosforilacija dovodi do 

aktivacije Akt koja nastavlja fosforilirati niz supstrata na serinskim i treoninskim ostatcima 

(21). U „distalnom inzulinskom signaliziranju“ Akt fosforilira više proteina kako bi pokrenuo 

složene stanične promjene. Akt dovodi do fosforilacije TBC1D4 supstrata koji vezanjem za 

vezikule za pohranu transportera glukoze 4 (engl. Glucose transporter type 4 - GLUT4) 

omogućuje translokaciju GLUT4 na staničnu membranu (20). Mogući mehanizmi nastanka 

inzulinske rezistencije uključuju smanjenu regulaciju, nedostatke ili genetske polimorfizme 

fosforilacije inzulinskih receptora, IRS-a ili PIP-3 kinaze ili može nastati zbog abnormalnosti 

GLUT4 (22). Smanjenje fosforilacije tirozin kinaze IR-a i aktivnosti receptorske tirozin 

kinaze uočeno je i kod trudnica s normalnom tolerancijom glukoze i kod onih s GDM-om, 

međutim kod žena s normalnom tolerancijom nakon poroda dolazi do nestanka navedenih 

smanjenja, dok kod žena s GDM-om ne dolazi do značajnog poboljšanja (23). Također, 

tijekom trudnoće postoji ravnomjerno smanjenje inzulinske osjetljivosti od 50 – 60 % s 

odmakom trudnoće koje se javlja i kod normalne tolerancije glukoze i kod GDM-a (24). 

Tijekom inzulinske rezistencije dolazi do smanjenog inzulinom stimuliranog unosa glukoze 

što dodatno doprinosi razvoju hiperglikemije, dovodeći do preopterećenja β-stanica koje 

moraju proizvesti dodatan inzulin kao odgovor na hiperglikemiju (1). Dugotrajno izlaganje 

hiperglikemiji može dovesti do glukotoksičnosti koja izaziva disregulaciju β-stanica i 

konačno smrt stanice (25). Dakle, GDM razvija se kada funkcija gušterače ne uspijeva 

prevladati inzulinsku rezistenciju. Nadalje, inzulinska rezistencija tijekom trudnoće razvija se 

kao rezultat povišene razine hormona rasta i kortizola, prisutnosti humanog placentarnog 
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laktogena (hPL), te zbog oslobađanja inzulinaza iz posteljice i visokih razina estrogena i 

progesterona (26). hPL povećava se do 30 puta tijekom trudnoće i potiče oslobađanje inzulina 

iz gušterače u trudnoći te može utjecati na razvoj inzulinske rezistencije. Nadalje, tijekom 

trudnoće dolazi do lučenja humanog placentarnog hormona rasta (hPGH), koji zamjenjuje 

hormon rasta hipofize, te se njegovo lučenje povećava 6 – 8 puta tijekom trudnoće. 

Prekomjerni izražaj hPGH može dovesti do razvoja inzulinske rezistencije (27). Činjenica da 

se inzulinska osjetljivost majke vraća na razinu prije trudnoće već nekoliko dana nakon 

poroda, pokazuje važnost placentarnih hormona u razvoju inzulinske rezistencije (1). Također, 

čimbenik nekroze tumora alfa (engl. Tumor necrosis factor alpha - TNF-α), kojeg proizvode 

monociti i makrofagi, smanjuje osjetljivost inzulina pri visokim koncentracijama, neizravno 

razvijajući hiperglikemiju, što dovodi do razvoja GDM-a kod trudnica (28). Ključna uloga 

ovog citokina je slabljenje izražaja GLUT4 u masnom tkivu, skeletnim mišićima i srčanom 

mišiću. Pretpostavlja se da više TNF-α luči placenta nego masno tkivo (29).  

 

1.4.2. Inzulinski receptor u miometriju  

 

Maternica je organ čija je stijenka građena od tri sloja tkiva. Prvi sloj čini endometrij 

koji reagira na reproduktivne hormone, zatim miometrij koji je mišićni sloj i sastoji se od 

glatkih mišićnih stanica te seroze ili perimetrija (30). Miometrij je najdeblji sloj maternice te 

ga čine snopovi glatkih mišićnih stanica odijeljenih vezivnim tkivom i raspoređeni u četiri 

neoštro ograničena sloja. Nadalje, tijekom trudnoće miometrij prolazi kroz razdoblje 

intenzivnog rasta koji je posljedica hiperplazije i hipertrofije (31). U istraživanju koje je 

provedeno kako bi se ispitao izražaj IR-a, IGF-1 receptora i glukokortikoidnih receptora u 

maternici štakorica, dokazano je postojanje IR-a u glatkim mišićima miometrija te je uočeno 

da se njegov izražaj mijenja tijekom različitih tjedana gestacije (32). Inzulinski receptori 

imaju ključnu ulogu u plodnosti i implantaciji te nedostatak dovodi do smanjene plodnosti, 

implantacije te neuspjeha decidualizacije. Nedostatak IR-a dovodi do smanjena proliferacije 

epitela maternice i strome. Također, IR zajedno s IGF1 receptorom ima bitnu ulogu u 

prevođenju signala ovisnih o hormonima koji upravljaju proliferacijom maternice (33). 
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2. HIPOTEZA 

 

Izlaganje prehrani bogatom mastima i šećerima prije i tijekom trudnoće smanjuje 

izražaj inzulinskog receptora alfa u mišiću maternice Sprague-Dawley štakorica.
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3. CILJ 

 

Imunohistokemijskim metodama, uz pomoć protutijela na inzulinski receptor alfa (IR-

α), obojiti tkiva maternice štakorica hranjenih standardnom ili prehranom bogatom mastima i 

šećerima od 3. tjedna starosti te usporediti izražaj inzulinskih receptora alfa u tkivu 

miometrija štakorica hranjenih standardnom i prehranom bogatom mastima i šećerima.
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4. MATERIJALI I METODE  

 

4.1. Ustroj studije  

 

Eksperimentalna studija na animalnom modelu – studija parova.  

 

4.2. Materijali  

 

Studija je napravljena na arhivi tkiva maternica prikupljenih u sklopu studije 

RECOOP-CMSC Senior Scientist (RCSS) Grant 2018-2020 #012: „The role of obesity-

induced low-grade inflammation in the adipokine signaling in pregnant rat uterus“ koju je 

odobrilo Mađarsko etičko povjerenstvo za pokuse na životinjama, br. IV./3071/2016 i Etičko 

povjerenstvo Medicinskog fakulteta Osijek 27. lipnja 2023., klasa: 602-04/23-08/03, 

URBROJ: 2158-61-46-23-114. U istraživanju su korištene ženke Sprague-Dawley štakora 

koje su od 3. tjedna starosti hranjene standardnom prehranom (SD) ili prehranom bogatom 

mastima i šećerima (HFHSD) (Altromin Spezialfutter GmbH & Co., Lage, Njemačka, kat. br. 

C-1101). Hranjene su 6 tjedana te se navedena prehrana nastavila primjenjivati od parenja do 

poroda. Nakon poroda štakorice su eutanazirane te je od svake životinje prikupljeno šest vrsta 

tkiva. Za potrebe izrade ovog završnog rada upotrijebljena su tkiva maternice 5 štakorica 

hranjenih sa SD koje predstavljaju kontrolnu skupinu te tkiva maternice 5 štakorica hranjenih 

s HFHSD te one predstavljaju eksperimentalnu skupinu. 

 

4.3. Metode 

 

Prisutnost IR-α u tkivu maternice analizirana je imunohistokemijskom metodom. 

Nakon fiksacije u 4 %-tnoj puferiranoj otopini formaldehida tijekom 24 sata, tkiva su 

uklopljena u parafinske blokove standardnim postupkom. Uslijedilo je rezanje na rezove 

debljine 5 µm pomoću mikrotoma (Leica SM2000R, Nussloch, Njemačka). Rezovi su 

deparafinizirani te je provedeno imunohistokemijsko bojanje tkiva koristeći protutijelo na IR-

α.  



4. MATERIJALI I METODE 

 

10 

  

 

4.3.1. Deparafinizacija tkiva 

 

Proces deparafinizacije započet je uranjanjem preparata dva puta u ksilol po 5 minuta. 

Nakon toga izvršena je rehidratacija u silaznom nizu alkohola. Preparat je prvo uronjen u 100 

%-tni etanol, zatim u 96 %-tni etanol, u 70 %-tni etanol te na kraju u destiliranu vodu, sve u 

trajanju od 5 minuta.  

 

4.3.2. Imunohistokemijsko bojanje 

 

Imunohistokemijsko bojanje je učinjeno prema sljedećem protokolu: 

1. Predtretman rezova u svrhu zasićenja endogenih peroksidaza koji podrazumijeva 

inkubaciju u 1 %-tnoj otopini vodikovog peroksida (Kemika, Zagreb) pripremljenog u 

puferu 1× PBS (pH 7,4; 137 mM NaCl (Gram Mol d.o.o., Zagreb, Hrvatska), 2,7 mM 

KCl (VWR International, Radnor, Pennsylvania, SAD), 10 mM NaH2PO4 (Gram Mol 

d.o.o., Zagreb, Hrvatska), 1,8 mM KH2PO4 (Sigma-Aldrich, St. Louis, Missouri, 

SAD) u trajanju od ukupno 40 minuta. 

2. Inkubacija rezova s otopinom za blokiranje u svrhu sprječavanja nespecifičnih reakcija 

u trajanju od 2 sata pri 4 °C. Otopina za blokiranje je bila 1 %-tni albumin iz seruma 

goveda (Sigma-Aldrich, St. Louis, Missouri, SAD) i 5 %-tni kozji serum (Gibco, 

Invitrogen, Auckland, Novi Zeland) pripremljeni u 1× PBS-u. 

3. Inkubacija rezova u otopini primarnog protutijela, zečjem protu-IR-α (Santa Cruz 

Biotechnology, Dallas, TX, USA; SC-710), pripremljenog u otopini za blokiranje u 

razrjeđenju 1 : 250. Inkubacija je trajala preko noći pri 4 °C. 

4. Ispiranje rezova tri puta po 10 minuta u 1× PBS-u. 

5. Inkubacija rezova u otopini sekundarnog protutijela, biotiniliranog protu-zečjem IgG 

(Jackson ImmunoResearch Laboratories, Inc. West Grove, PA, USA), pripremljenog u 

otopini za blokiranje u razrjeđenju 1 : 1000. Inkubacija je trajala 4 sata pri 4 °C. 

6. Ispiranje rezova tri puta po 10 minuta u 1× PBS-u. 

7. Inkubacija rezova u otopini kompleksa avidin – biotin s peroksidazom hrena (HRP) 

(Vector Laboratories, Burlingame, CA, SAD) pripremljenog prema uputama 

proizvođača, u trajanju od 2 sata pri 4 °C. 



4. MATERIJALI I METODE 

 

11 

  

8. Ispiranje rezova tri puta po 10 minuta u 1× PBS-u. 

9. Vizualizacija kompleksa antigen-protutijelo korištenjem otopine diaminobenzidina 

(Vector Laboratories, Burlingame, CA, SAD), supstrata za HRP, pripremljene prema 

uputama proizvođača. 

10. Pokrivanje stakalaca s rezovima medijem za pokrivanje i pokrovnim stakalcem.  

 

4.3.3. Analiza mikrofotografija  

 

Preparati su mikroskopirani i fotografirani koristeći svjetlosni mikroskop (Carl Zeiss, 

Axioskop 2 MOT, Jena, Njemačka) spojen na kameru (Olympus DP70, Optical Olympus, 

Japan) te su dobivene fotografije analizirane. Fotografiranje je napravljeno na povećanju 

objektiva 40×. Na svakom tkivu fotografirano je 6 fotografija; 3 fotografije vanjskog 

miometrija i 3 fotografije unutarnjeg miometrija. Nakon toga kvantificiran je izražaj IR-α u 

računalnom programu ImageJ 1.53k, dodatak Fiji (34). Postupak navedene analize u Fiji-ju 

podrazumijeva odabir sljedećih naredbi pri pregledu odabrane mikrofotografije:  

1. Image → Type → 8-bit  

2. Image → Adjust → Brightness / Contrast → auto 

3. Edit → Selection → Specify (za svaku fotografiju korišten je jedan kvadrat veličine 

900 × 900 piksela) 

4. Analyze → Measure  

Kao mjerni parametar korištena je srednja vrijednost intenziteta sive boje (mean) i standardna 

devijacija. Podatci su uneseni u tablice i iskorišteni za statističku obradu.  

 

4.4. Statističke metode 

 

Numerički podatci opisani su aritmetičkom sredinom i standardnom devijacijom u 

slučaju raspodjele koja slijedi normalnu, a u ostalim slučajevima medijanom i granicama 

interkvartilnog raspona. Razlike normalno raspodijeljenih numeričkih varijabli između 

nezavisnih skupina testirane su Studentovim t testom, a u slučaju odstupanja od normalne 

raspodjele Mann-Whitneyevim U testom. Sve p vrijednosti su dvostrane. Razina značajnosti 
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je postavljena na α = 0,05. Za statističku analizu korišten je program GraphPad Prism, inačica 

9.5.1 (GraphPad Software, Boston, MA, SAD).  
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5. REZULTATI  

 

5.1. Imunohistokemija na IR-α 

 

Imunohistokemijskom metodom, uz pomoć protutijela na IR-α, obojana su tkiva 

maternice štakorica hranjenih standardnom prehranom (SD) ili prehranom bogatom mastima i 

šećerima (HFHSD) od 3. tjedna starosti. Zabilježeno je da je IR-α izražen u vanjskom (Slika 

1) i unutarnjem miometriju maternica u obje analizirane skupine (Slika 2).  

Slika 1. Imunohistokemijsko obojenje vanjskog sloja miometrija maternice na inzulinski receptor IR-α. Prikaz 

usporedbe dvaju skupina štakorica s obzirom na način prehrane te u odnosu na kontrolu. Fotografirano na 400× 

povećanju mikroskopa. Mjerilo: 20 µm. → - imunopozitivna reakcija, HFHSD – prehrana bogata mastima i 

šećerima, IR-α – inzulinski receptor alfa, SD – standardna prehrana. Autor fotografije: Patricija Budić. 
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Kontrola IR-α 

SD 
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Miometrij unutarnji 

sloj 
Kontrola IR-α 

SD 

  

HFHSD 

  

Slika 2. Imunohistokemijsko obojenje unutarnjeg sloja miometrija maternice na inzulinski receptor IR-α. Prikaz 

usporedbe dvaju skupina štakorica s obzirom na način prehrane te u odnosu na kontrolu. Fotografirano na 400× 

povećanju mikroskopa. Mjerilo: 20 µm. → - imunopozitivna reakcija, HFHSD – prehrana bogata mastima i 

šećerima, IR-α – inzulinski receptor alfa, SD – standardna prehrana. Autor fotografije: Patricija Budić. 

 

5.2. Usporedba izražaja IR u tkivu miometrija SD i HFHSD skupini  

 

Uspoređeni su podatci dobiveni analizom izražaja IR-α u unutarnjem miometriju 

štakorica SD skupine i unutarnjem miometriju štakorica HFHSD skupine. Podatci obje 

skupine slijedili su normalnu distribuciju (Shapiro-Wilkov test, SD: p = 0,064, HFHSD: p = 

0,266). Studentovim t testom zabilježen je p = 0,652. Navedeno znači da nema statistički 

značajne razlike u izražaju IR-α u unutarnjem miometriju između navedenih skupina (Slika 

3).  

Osim toga, uspoređeni su podatci dobiveni analizom izražaja IR-α u vanjskom 

miometriju štakorica SD skupine i vanjskom miometriju štakorica HFHSD skupine. Podatci 

obje skupine također su slijedili normalnu distribuciju (Shapiro-Wilkov test, SD: p = 0,062, 

HFHSD: p = 0,232) te su navedene skupine uspoređene Studentovim t testom. Dobivena je p 

vrijednost u iznosu 0,034. Navedeno znači da se razina izražaja u vanjskom sloju miometrija 
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SD skupine statistički značajno razlikuje od razine izražaja IR-α u vanjskom sloju miometrija 

HFHSD skupine (Slika 4).  

 

 

Slika 3. Grafički prikaz izražaja IR-α u unutarnjem sloju miometrija maternice štakorica hranjenih standardnom 

prehranom (SD) i hranjenih prehranom bogatom mastima i šećerima (HFHSD). Vrijednost izražaja IR-α izražena 

je u obliku aritmetičke sredine (engl. mean value), koja predstavlja zbroj vrijednosti svih piksela podijeljen s 

ukupnim brojem piksela u području od interesa (vrijednost u rasponu 0 do 255). Nije utvrđena statistički 

značajna razlika među skupinama (p = 0,652). 
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Slika 4. Grafički prikaz izražaja IR-α u vanjskom sloju miometrija maternice štakorica hranjenih standardnom 

prehranom (SD) i hranjenih prehranom bogatom mastima i šećerima (HFHSD). Vrijednost izražaja IR-α izražena 

je u obliku aritmetičke sredine (engl. mean value), koja predstavlja zbroj vrijednosti svih piksela podijeljen s 

ukupnim brojem piksela u području od interesa (vrijednost u rasponu 0 do 255). Utvrđena je statistički značajna 

razlika među skupinama (p = 0,034). 
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6. RASPRAVA 

 

Ovaj rad istražio je izražaj inzulinskog receptora alfa u postpartalnom miometriju 

Sprague-Dawley štakora nakon unosa hrane bogate mastima i šećerima. Navedeni način 

prehrane je jedan od glavnih čimbenika razvoja GDM-a i inzulinske rezistencije. Prehrana s 

visokim udjelom zasićenih masti, rafiniranih šećera te crvenog i prerađenog mesa povezana je 

s povećanim rizikom za razvoj GDM-a, dok je prehrana s visokim udjelom vlakana, 

mikronutrijenata i polinezasićenih masti povezana sa smanjenjem rizika za razvoj GDM-a (1). 

Nadalje, istraživanjima je dokazano da je visoki unos životinjskih masti i proteina povezan s 

povećanim rizikom za razvoj GDM-a, dok je veći unos biljnih bjelančevina bio povezan s 

manjim rizikom (35). Pića zaslađena šećerom povećavaju rizik za razvoj dijabetesa. Iako se 

sve češće koriste umjetni zaslađivači kao zamjena za šećer, istraživanja provedena na ljudima 

sugeriraju da kontinuirana izloženost umjetnim zaslađivačima može smanjiti akutni odgovor 

na inzulin te smanjiti inzulinsku osjetljivost (36). U istraživanju provedenom na vrsti 

Drosophila melanogaster zapaženo je da su larve koje su hranjene prehranom bogatom 

šećerima bile hiperglikemične, hiperinzulinemične te su pokazivale neispravan odgovor na 

inzulin. Slični rezultati su zapaženi i kod muških i kod ženskih odraslih muha. Također, 

navedeno istraživanje ukazuje na to da prehrana visokim udjelom šećera skraćuje životni 

vijek i izaziva srčanu disfunkciju i aritmije (37). Osim što dovode do razvoja inzulinske 

rezistencije pića zaslađena šećerima mogu dovesti i do prijevremenog poroda. Šećer dovodi 

do povećanja koncentracije glukoze u plazmi i do smanjenja osjetljivosti na inzulin. Smanjena 

inzulinska osjetljivost jedan je od faktora prijevremenog poroda, a visoke koncentracije 

glukoze u plazmi povezane su s povišenim koncentracijama interleukina koji su dio upalne 

reakcije te su povezani s prijevremenim porodom (11). Inzulinska rezistencija je vrlo često 

uzrokovana povećanom upalom u organizmu. Upala može biti uzrokovana visokim 

koncentracijama glukoze u krvi, pretilošću ili prehranom, odnosno masnim kiselinama. 

Konkretno, omega-6 zasićene masne kiseline (arahidonska i palmitinska kiselina) smatraju se 

proupalnim molekulama. Također, mogu se vezati na specifične vezne proteine koji mogu 

uzrokovati inzulinsku rezistenciju (38). Provedeno je istraživanje u kojemu je ispitivan utjecaj 

hiperinzulinemije na IR. Hiperinzulinemija, koja nastaje kao posljedica hiperglikemija, 

tijekom kroničnog djelovanja može dovesti do smanjenja fosforilacije IR-a. Međutim u 

navedenom istraživanju nije zapažena promjena u količini ili položaju IR-a (39).  
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Različitim istraživanjima dokazano je da hiperglikemija utječe na proliferaciju glatkih 

mišićnih stanica te da može imati stimulirajući ili inhibitorni učinak. Također, uočeno je da 

potrošnja glukoze glatkih mišićnih stanica ostaje vrlo visoka kod dijabetesa, odnosno da se 

ponašaju gotovo kao tumorske stanice po pitanju potrošnje glukoze. Međutim, glatke mišićne 

stanice koriste glikolitički put za stvaranje ATP-a (adenozin-trifosfata) čak i u anaerobnim 

uvjetima. Procesom aerobne glikolize glatke mišićne stanice štite se od oksidativnog stresa. 

Neke studije predlažu teoriju u kojoj kronična hiperglikemija dovodi do indukcije 

proliferacije i nakupljanja glatkih mišićnih stanica (40). Iz navedenih činjenica vidljivo je da 

se tijekom hiperglikemije povećava potrošnja glukoze u glatkim mišićnim stanicama te da 

kronična hiperglikemija može potaknuti proliferaciju i povećanje broja glatkih mišićnih 

stanica. Ukoliko dođe do povećanja broja mišićnih stanica, dolazi i do povećanog izražaja IR-

a. S obzirom da su štakorice hranjene prehranom bogatom mastima i šećerima, cijelo vrijeme 

bile su izložene hiperglikemiji koja je mogla dovesti do proliferacije i povećanja broja 

mišićnih stanica, a samim time i do povećanja broja IR-α. 

Hipotezom ovog istraživanja pretpostavljeno je da će doći do smanjenja broja IR-α 

međutim to je karakteristična pojava za skeletne mišiće, a ne za glatke mišićne stanice. 

Tijekom hiperinzulinemije većina glukoze se skladišti u skeletnim mišićima no kod kronične 

hiperinzulinemije dolazi do pojave inzulinske rezistencije. S napredovanjem inzulinske 

rezistencije i smanjenjem unosa glukoze u mišiće, porast koncentracije glukoze u plazmi 

postaje pretjeran, ali je porast hiperinzulinemije dovoljan da se održi koncentracija glukoze 

unutar normalnog raspona. Usprkos tome, dolazi do prekomjernog porasta koncentracije 

glukoze u plazmi te je potrebno više vremena za uspostavljanje normoglikemije nakon svakog 

obroka. Na kraju, međutim, inzulinska rezistencija postaje toliko jaka da kompenzacijska 

hiperinzulinemija nije dovoljna za održavanje normalnih razina glukoze. Dolazi do razvoja 

hiperglikemije koja i dalje stimulira lučenje inzulina iz β-stanica. Kronična hiperinzulinemija 

uzrokuje smanjenje broja IR-a i intracelularnih događaja uključenih u djelovanje inzulina, 

čime se pogoršava inzulinska rezistencija (41). Dakle, da je analiza izražaja IR-α provedena 

na skeletnim mišićima pretpostavljamo da bi došlo do smanjenja izražaja nakon izloženosti 

prehrani bogatom mastima i šećerima.  

Provedeno je istraživanje kako bi se ispitao utjecaj gestacijskog dijabetesa na 

kontraktilost miometrija. Uočeno je da postoje značajne razlike u kontrakcijama kod 

pacijenata s dijabetesom u odnosu na pacijente bez dijabetesa. Kontrakcije kod pacijenata s 

dijabetesom bile su slabije i trajale su kraće. Tijekom istraživanja zapaženo je da se smanjuje 
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signalizacija kalcijevih kanala koji su vjerojatno uzrok smanjene kontraktilosti. Smanjena 

signalizacija posljedica je smanjenog izražaja Ca2+ kanala u miometriju pacijenata s 

dijabetesom(42).  

Istraživanjima je dokazano da je normalni miometrij sastavljen od različitih fenotipova 

glatkih mišićnih stanica. Vanjski miometrij sastavljen je od terminalno diferenciranih glatkih 

mišićnih stanica dok je, s druge strane, unutarnji miometrij sastavljen od nediferenciranih 

glatkih mišićnih stanica (43). S obzirom da se vanjski i unutarnji miometrij razlikuju svojom 

građom za očekivati je da izražaj IR-α nije isti u navedenim slojevima. U ovom istraživanju 

došlo je do povećanja izražaja IR-α u vanjskom miometriju dok je u unutarnjem ostala gotovo 

nepromijenjena. Razlika u izražaju vidljiva je zbog razlike u tkivima, odnosno zbog različite 

diferencijacije glatkih mišićnih stanica.  
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7. ZAKLJUČAK  

 

Imunohistokemijskim metodama, uz pomoć protutijela na inzulinski receptor alfa (IR-

α), obojana su tkiva maternica štakorica hranjenih standardnom prehranom (SD) ili 

prehranom bogatom mastima i šećerima (HFHSD) te je utvrđen izražaj IR-α u unutarnjem i 

vanjskom miometriju u obje skupine. U unutarnjem miometriju nije utvrđena značajna razlika 

u izražaju IR-α između štakorica hranjenih standardnom prehranom i prehranom bogatom 

mastima i šećerima. S druge strane, u vanjskom je miometriju uočena značajna razlika u 

izražaju IR-α između dvije skupine te je utvrđena veća razina IR-α kod skupine hranjene 

prehranom bogatom mastima i šećerima (HFHSD) u odnosu na štakorice hranjene 

standardnom prehranom (SD).  
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8. SAŽETAK  

 

Cilj: Imunohistokemijskim metodama, uz pomoć protutijela na inzulinski receptor alfa (IR-α) 

obojiti tkiva maternice štakorica hranjenih standardnom prehranom ili prehranom bogatom 

mastima i šećerima od 3. tjedna starosti te usporediti izražaj inzulinskih receptora u tkivu 

miometrija štakorica hranjenih standardnom prehranom i prehranom bogatom mastima i 

šećerima. 

Ustroj studije: Eksperimentalna studija na animalnom modelu – studija parova. 

Materijali i metode: Studija je napravljena na arhivi tkiva maternica prikupljenih u sklopu 

studije RECOOP-CMSC Senior Scientist (RCSS) Grant 2018-2020  #012: „The role of 

obesity-induced low-grade inflammation in the adipokine signaling in pregnant rat uterus“. U 

istraživanju su korištene ženke Sprague-Dawley štakora koje su od 3. tjedna starosti hranjene 

standardnom prehranom (SD) ili prehranom bogatom mastima i šećerima (HFHSD). 

Prisutnost IR-α u tkivu maternice analizirana je imunohistokemijskom metodom. Nakon 

fiksacije u 4 %-tnoj puferiranoj otopini formaldehida tijekom 24 sata, tkiva su uklopljena u 

parafinske blokove standardnim postupkom. Na deparafiniziranim rezovima debljine 5 µm 

provedeno je imunohistokemijsko bojanje tkiva uz pomoć protutijelo na IR-α. Na kraju je 

provedena analiza mikrofotografija te statistička analiza dobivenih podataka. 

Rezultati: U vanjskom miometriju štakorica hranjenih prehranom bogatom mastima i 

šećerima (HFHSD) dolazi do povećanja izražaja inzulinskih receptora alfa u odnosu na 

štakorice hranjene standardnom prehranom (SD).  

Zaključak: Imunohistokemijskom metodom uz pomoć protutijela na IR-α obojana su tkiva 

maternica te je zapaženo povećanje izražaja IR-α u vanjskom miometriju HFHSD skupine.  

Ključne riječi: gestacijski dijabetes, inzulinski receptor, inzulinska rezistencija.
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 Insulin receptor expression in the postpartum myometrium of female Sprague-Dawley rats 

after exposure to a diet rich in fats and sugars 

 

Objective: Immunohistochemical methods, with the help of antibodies to the insulin receptor 

alpha (IR-α), to stain the uterine tissues of rats fed a standard diet or a diet rich in fats and 

sugars from the 3rd week of age and to compare the expression of insulin receptors in the 

myometrial tissue of rats fed standard diet and diet rich in fats and sugars.  

Study desing: Experimental research on an animal model – the case-control study.  

Material and methods: The research was made on the archive of uterine tissues collected as 

part of the study RECOOP-CMSC Senior Scientist (RCSS) Grant 2018-2020  #012: „The role 

of obesity-induced low-grade inflammation in the adipokine signaling in pregnant rat uterus“. 

The research used female Sprague-Dawley rats that were fed a standard diet (SD) or a diet 

rich in fats and sugars (HFHSD) from the 3rd week of age. The presence of IR-α in uterine 

tissue was analyzed by immunohistochemical method. After fixation in 4 % buffered 

formaldehyde solution for 24 hours, the tissue were embedded in paraffin blocks using a 

standard procedure. Immunohistochemical tissue staining was performed on deparaffinizde 

sections with a thickness of 5 µm using an antibody to IR-α. At the end, an analysis of 

microphotographs and statistical analysis of the obtained data was carried out.   

Results: In the outer myometrium of rats fed a diet rich in fats and sugars (HFHSD), there is a 

increase in the expression of insulin receptors alpha compared to rats fed a standard diet (SD).  

Conclusion: Uterine tissues were stained with an immunohistochemical method using IR-α 

antibodies, and an increase expression was observed in the outer myometrium of the HFHSD 

group.  

Key words: gestational diabetes, insulin receptor, insulin resistance. 
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